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Preface
This Getting Started guide will help you install SmarTerm on your PC. This 
guide, in combination with the more detailed online help system, and with 
online manuals, provides you with what you need to use SmarTerm.

This guide provides instructions for installing SmarTerm in the language of 
your choice—English, French, German, or Spanish—and provides an over-
view of installation. After reading this Preface, turn to “Installing Smar-
Term” for instructions on running Setup.

For information on the Administrator Toolbox, including creating profiles 
and profile servers or deploying SmarTerm for network users, see the System 
Administrator Guide (English only).

Information and technical support
If you encounter problems with SmarTerm, check through the troubleshoot-
ing hints in the online help and SmarTerm documentation. Many situations 
are common and can be corrected easily with the suggestions given there. If 
your problems persist, call Esker’s Technical Support department for assis-
tance.

Before you call for technical support:

•  Know your license number. It’s on the Registration card that comes with 
your product.  (If you entered the number during installation, you can dis-
play this license number by selecting Help > About.)

•  Be aware that we may need detailed information about the hardware and 
software on your computer, so a working knowledge of Windows, the 
setup of your PC, and the way you are using SmarTerm may be necessary.

•  Isolate the problem as much as possible. Does the problem occur every 
time you enter a certain sequence of keystrokes, or do you have to do 
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Getting Started Guide
something else first? Writing down a short description of the steps it takes 
to repeat the problem will help both of us to isolate the problem.

•  Seat yourself at the PC that is giving you trouble and call us from there. We 
may need to have you run one or more diagnostic tests, and these must be 
done on the computer with the problem.
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1
Installing SmarTerm

SmarTerm is an integrated set of Windows applications that put you online 
with the most popular connectivity methods in use today. SmarTerm is a 
multilingual product, operating in your choice of English, French, German, 
or Spanish, while allowing you to change languages without disconnecting 
from your host or exiting SmarTerm.

This chapter steps through the installation of SmarTerm.

Installation requirements
SmarTerm runs on any system that has the following hardware and software:

•  The minimum computer hardware and memory that is required by Win-
dows XP/Windows Vista/Windows Server 2003 or Windows Server 2008 
installation on a PC with Intel or compatible processors. 

•  Windows XP/Windows Vista 32-bit or 64-bit/Windows Server 2003 32-
bit/Windows Server 2008 32-bit or 64-bit, with the latest service packs 
installed.

•  Screen resolution set to at least 800 x 600 with 256 colors.

•  Appropriate communication hardware and software, such as a serial port 
or modem, if you intend to use a direct serial connection or a modem con-
nection.

•  The Windows TCP/IP stack if you intend to use the Telnet connection 
method or FTP.

•  Microsoft SNA client if you intend to use this connection method

•  Adobe® Acrobat Reader 4.0.5 to read the manuals. You can download this 
software from the Adobe web site. 

•  46MB of free disk space to install all components and languages.
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Before you install
Below are some things you should know about before you install SmarTerm. 
Read through the next sections to see if there are any steps you need to take 
before running Setup to install SmarTerm.

Have your serial number handy
Setup prompts you for your name, your serial number and your activation key  
for the product your purchased. (To display your serial number after installa-
tion, simply select Help > About.) You must register SmarTerm to obtain a 
serial number.

Shut down extra Windows programs
To make installation go as smoothly as possible, shut down any programs run-
ning in the background, such as:

•  Applications

•  Virus protection programs

Multilingual options
You can run Setup in English, French, German, or Spanish. The language you 
choose for Setup becomes the default language the first time you run Smar-
Term.

Note:
Setup will always install English components, but you can install French, Ger-
man, and Spanish components as well. Whatever languages you choose to 
install are available to you in any session you use to connect to a host. Lan-
guage switching is dynamic, meaning that you can start a session in French 
and switch to German without disconnecting from the host or exiting Smar-
Term. Language changes affect the menus and dialogs. The online help is pro-
vided in English only.
6



  1 Installing SmarTerm
Installation type
You can choose between two types of installation: Complete and Custom. 
Complete installs all the features of SmarTerm except the Administrator 
Toolbox, and is recommended for a first-time installation. Custom allows 
you to choose the SmarTerm components that you want to install.

Note:
If you want to install the Administrator Toolbox, you must choose Custom 
and then select Administrator Tools to install the Administrator Toolbox.

To install SmarTerm to a path other than the default, choose Custom installa-
tion and click the Change button. Then enter the path you want.

Run setup
Follow the steps below to run Setup:

1. Insert the CD into the CD-ROM drive and choose Install SmarTerm from the 
CD browser window. 

Note:
If the “autorun” feature is disabled or unavailable, run smarterm.exe from 
the root directory of the CD.

2. Select the language for the installation program.

3. Follow the prompts Setup presents to you. 

If you don’t like the defaults, type in new values or select a value from the 
list boxes or check boxes on a dialog. If you are unsure of the appropriate 
response to a prompt, consult the online help for detailed information about 
your choices or simply accept the defaults.
7
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Notes:
Configuration files are saved on a per-user basis in that user's documents and 
settings location.

The required Esker Licensing Service tracks the number of instances of Smar-
Term  running on a network. It does this by broadcasting license information 
every 15 minutes, via UDP port 47474.

Upgrading SmarTerm from an evaluation 
copy to a licensed copy

Once you purchase a copy of SmarTerm from Esker Sales or your reseller, you 
can use the Esker Licensing Administration utility to upgrade an evaluation 
copy of SmarTerm to a licensed copy. 

1. Select Start > Programs > SmarTerm > Utilities > Esker Licensing Adminis-
tration.

2. Highlight the SmarTerm product you want to upgrade.

3. Click the Modify the serilization info button . 

4. Enter the new Serial number and Activation key and click OK.

You may now run your licensed copy of SmarTerm.

Updating custom files from older versions 
of SmarTerm

You can use custom files that you’ve created using a version 6.0 SmarTerm 
product or greater with this new version of SmarTerm. These files include ses-
sion configuration (.STW), keyboard (.KBO), and script language (.PSL). 
Custom files from versions 7.0 through 11.0 SmarTerm are all set for use with 
this version—there is no file conversion required. Just use the files as you did 
in those versions of  SmarTerm. There are certain rules that you should keep 
in mind when updating custom files:

•  Keep an archive of all your old files. This means backing up the files to a 
network server location or backing up to a diskette. SmarTerm creates back-
8



  1 Installing SmarTerm
ups for some files, but it’s best to keep your own copies, should you ever 
want to use the older files again.

•  Conversions are done locally on a PC. If you plan to make the converted 
files available to network users, you can test locally and copy them to a  
folder on the network server.

•  Most conversions are done automatically but you need to copy the older 
files to the correct default file locations. 

Updating session (.STW) files
1. Start up SmarTerm, if you do not already have it running.

2. Pull down the File menu. 

A list of available .STW files appears. 

3. Select an .STW. As soon as you select it, it is converted.

Once the list appears, you have converted all your session files. During con-
version, SmarTerm makes a copy of the original .STW files and changes the 
extension to .BAK. Converted files are written out as .STW files.

Note:
After you have tested the new session files to see if the conversion was suc-
cessful, you may want to remove the .BAK files, which are no longer used 
by SmarTerm.

Things to keep in mind
If the old .STW file used a login script (.psl), it is converted to the new 
macro language and embedded in the new session file. (Remember that .psl 
files need to be in the \Macros folder.)

If the old .STW file connected through a modem to a host, it is converted to 
use the Direct Serial connection type. You will have to create a new .STW 
file for use with a modem. (SmarTerm uses Microsoft's TAPI interface for 
Windows.)

The settings in the Preferences dialog in the pre-version 6.0 products are not 
converted into the new .STW format. 
9
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Updating keyboard (.KBO) files

Note:
If you are converting TN3270 Addition keyboard map files, you need to 
rename the .KB2 extension to .KBO before converting to the new SmarTerm 
format.

1. Start up SmarTerm, if you do not already have it running. 

2. Select Tools > Keyboard Maps. 

A list of available keyboard maps and the old .KBO files appears.

3. Select a keyboard map file, and click Edit.

4. Select File > Save.

Once you save the old .KBO file, it is converted to the new format. During 
conversion, SmarTerm makes a copy of the original .KBO files and changes 
the extension to .BAK. Converted files are written out as .KBO files.

Note:
After you have tested the new keyboard maps to see if the conversion was suc-
cessful, you may want to remove the .BAK files, which are no longer used by 
SmarTerm.

What to do next
For information on the Administrator Toolbox, including creating profiles and 
profile servers or deploying SmarTerm for network users, see the System 
Administrator Guide (English only).
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Préface
Ce guide Pour Démarrer vous aide à installer SmarTerm sur votre PC. Con-
sulté en complément de l’aide en ligne, plus détaillée, et des manuels en 
ligne, il vous fournit toutes les instructions nécessaires pour utiliser Smar-
Term.

Ce guide explique comment installer SmarTerm dans la langue de votre 
choix (français, anglais, allemand ou espagnol) et détaille les différentes 
options d’installation. Après avoir pris connaissance de cette préface, passez 
à “Installation de SmarTerm” pour obtenir les instructions sur la manière 
d’exécuter le programme d’installation.

Pour des informations sur l’Administrator Toolbox, notamment la création 
de profils et de serveurs de profils ou le déploiement de SmarTerm pour les 
utilisateurs réseau, consultez la publication System Administrator Guide (en 
anglais uniquement).

Support technique et informations
Si vous rencontrez des difficultés en utilisant SmarTerm, prenez connais-
sance de l’aide en ligne et de la documentation. Si les problèmes persistent, 
appelez l’équipe de support technique d’Esker.

Avant d’appeler le support technique :

•  Munissez-vous de votre numéro de licence : vous le trouverez dans la carte 
d’enregistrement du logiciel qui accompagne votre produit. (Si vous avez 
entré le numéro en cours d’installation, sélectionnez Aide > A propos.)

•  Vous devrez sans doute fournir des informations détaillées concernant le 
matériel et les logiciels de votre ordinateur. Une bonne connaissance de 
Windows, ainsi que des informations sur la configuration de votre PC et la 
manière dont vous utilisez SmarTerm seront nécessaires.
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Pour Démarrer
•  Isolez le problème autant que possible. Se produit-il lorsque vous tapez une 
certaine séquence de touches ou après une opération quelconque ? Il est très 
utile de rédiger une brève description des étapes qui mènent à ce problème : 
cela nous permettra de mieux le cerner.

•  Restez à proximité de votre PC lorsque vous nous appelez. Il est en effet fort 
possible que nous vous demandions d’exécuter quelques tests sur l’ordina-
teur.
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Installation de SmarTerm

SmarTerm est un ensemble intégré d’applications Windows qui mettent 
votre système en ligne grâce aux méthodes de connectivité les plus popu-
laires actuellement. SmarTerm est un produit multilingue qui vous permet de 
travailler dans la langue de votre choix—allemand, anglais, français ou 
espagnol—vous pouvez changer de langue sans avoir à vous déconnecter de 
l’hôte ou à quitter SmarTerm.

Ce chapitre vous guide tout au long de l’installation de SmarTerm.

Configuration requise
SmarTerm tourne sur tout système disposant des éléments matériel et 
logiciel suivants :

•  matériel et mémoire minimum requis par l’installation de Windows XP/
Windows Vista/Windows Server 2003 ou Windows Server 2008 sur un PC 
équipé d’un processeur Intel ou compatible ;

•  Windows XP/Windows Vista 32-bit ou 64-bit/Windows Server 2003 32-
bit/Windows Server 2008 32-bit ou 64-bit, avec les derniers Service Pack ;

•  résolution d'écran définie à 800 x 600 au moins, avec 256 couleurs  ;

•  matériel et logiciel de communication appropriés, tels qu’un port série ou 
modem, si vous prévoyez d’utiliser une connexion série directe ou une 
connexion via modem ;

•  la pile TCP/IP Windows, si vous prévoyez d’utiliser la méthode de con-
nexion Telnet ou FTP ;

•  client SNA Microsoft si vous prévoyez de supporter cette méthode de con-
nexion ;
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Pour Démarrer
•  Adobe® Acrobat Reader 4.0.5 pour lire les manuels. Vous pouvez télé-
charger ce logiciel depuis le site Web d’Adobe. 

•  46 Mo d’espace disque libre pour installer tous les composants et modules 
de langue.

Avant l’installation
Lisez attentivement les sections suivantes pour déterminer les étapes à effec-
tuer avant d’exécuter le programme d’installation pour installer SmarTerm. 

Ayez votre numéro de série à portée de main
Le programme d’installation vous invite à entrer vos nom, et numéro de série 
pour le produit que vous avez acheté. (Pour afficher votre numéro de série 
après l’installation, sélectionnez simplement Aide>A propos de.) Vous devez 
inscrire SmarTerm pour obtenir un numéro de série.

Quittez tous les autres programmes Windows
Pour faciliter autant que possible la procédure d’installation, désactivez tout 
programme exécuté en arrière-plan, tel que :

•  des applications

•  des programmes anti-virus.

Options multilingues
Vous pouvez exécuter le programme d’installation en allemand, en anglais, en 
français ou en espagnol. La langue que vous choisirez deviendra la langue par 
défaut lors de l’exécution initiale de SmarTerm.

Notez également que le programme d’installation installera toujours le mod-
ule anglais, mais que vous pouvez également installer les modules français, 
allemand et/ou espagnol. Les langues que vous choisissez d’installer seront 
disponibles lors de n’importe quelle session de connexion à un hôte. Le 
changement de langue est dynamique ; ceci signifie que vous pouvez initia-
liser une session en français puis passer à l’allemand sans vous déconnecter de 
l’hôte ni même quitter SmarTerm. Les changements de langue affectent les 
menus et boîtes de dialogue. L’aide en ligne est disponible en anglais unique-
ment.
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  1 Installation de SmarTerm
Type d’installation
Vous avez le choix entre deux types d’installation : Complète et Personnal-
isée. L’installation complète installe toutes les fonctionnalités de SmarTerm, 
sauf l’Administrator Toolbox ; elle est recommandée lors de votre installa-
tion initiale. L’installation personnalisée permet de sélectionner individu-
ellement les composantes SmarTerm à installer.

Remarque:
Pour installer l’Administrator Toolbox, choisissez Installation personnalisée, 
puis sélectionnez Outils d’administration.

Pour installer SmarTerm dans un répertoire autre que le répertoire par défaut, 
choisissez Installation personnalisée et cliquez sur le bouton Modifier. 
Entrez ensuite le chemin que vous voulez utiliser.

Exécution du programme d’installation
Observez les étapes suivantes pour exécuter le programme d’installation :

1. Insérez le CD dans le lecteur de CD-ROM et choisissez Install SmarTerm à 
partir de la fenêtre du CD Browser. 

Remarque:
Si la fonction d’exécution automatique est désactivée ou non disponible, 
exécutez smarterm.exe à partir du répertoire racine du CD.

2. Sélectionnez la langue d’installation.

3. Répondez aux invites affichées par le programme d’installation. 

Si les valeurs proposées par défaut ne vous conviennent pas, tapez de nouv-
elles valeurs ou sélectionnez une valeur dans les zones de liste ou les cases à 
cocher des boîtes de dialogue que vous obtenez. Dans le doute quant à la 
réponse à fournir à une invite, consultez l’aide en ligne pour obtenir des 
informations détaillées sur les choix disponibles, ou simplement validez  les 
options par défaut.
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Remarque :
Les fichiers de configuration sont enregistrés pour l'utilisateur spécifique dans 
son dossier de documents et de paramètres. 

Le services des licences Esker requis contrôle le nombre d’instances de Smar-
Term  exécutées sur un réseau par la publication chaque 15 minutes des infor-
mations de licence, via le port UDP 47474.

Actualiser SmarTerm de la version 
d'évaluation à la version sous licence

Si vous achetez une copie de SmarTerm au service des ventes d'Esker ou 
auprès de votre revendeur, vous pouvez utiliser l'utilitaire de gestion des 
licences, Esker Licensing Administration, pour passer de votre version d'éval-
uation à une version permanente autorisée de SmarTerm. Pour cela : 

1. Sélectionnez Démarrer > Programmes > SmarTerm > Utilitaires > Esker 
Licensing Administration.

2. Mettez en surbrillance le produit SmarTerm que vous désirer actualiser.

3. Cliquez sur le bouton Modifier les infos de sérialisation . 

4. Entrez le nouveau numéro de série et le code d'activation, puis cliquez sur 
OK.

Vous pouvez maintenant exécuter votre copie permanente autorisée de Smar-
Term.

Mettre à jour les fichiers personnalisés
Vous pouvez utiliser les fichiers personnalisés que vous avez créés en utilisant 
la version 6.0 ou ultérieure d’un produit SmarTerm avec cette nouvelle ver-
sion de SmarTerm. Les fichiers personnalisés des versions 7.0 à 11.0 de Smar-
Term sont tous définis pour l’utilisation avec cette version—pas de conversion 
de fichier requise. Utilisez simplement les fichiers tout comme vous l’avez 
fait pour ces versions de SmarTerm. Ne perdez pas de vue les quelques règles 
suivantes lorsque vous mettez des fichiers personnalisés à jour :
8



  1 Installation de SmarTerm
•  Conservez une version archivée de tous vos anciens fichiers. Ceci impli-
que de procéder à une copie de sauvegarde de ces fichiers sur un serveur 
de réseau ou sur disquette/CD-ROM. SmarTerm crée des copies de sauve-
garde de certains fichiers mais il est conseillé d’archiver vos propres cop-
ies au cas où vous auriez besoin de réutiliser vos anciens fichiers.

•  Les conversions s’opèrent localement sur un PC. Si vous prévoyez de per-
mettre aux utilisateurs réseau d’accéder aux fichiers convertis, testez-les 
localement et copiez-les dans un dossier sur le serveur réseau.

•  La plupart des conversions s’opèrent automatiquement mais vous devrez 
copier les anciens fichiers aux emplacements de fichier par défaut appro-
priés. 

Mettre à jour les fichiers de session (.STW)
1. Démarrez SmarTerm, si ce n’est pas déjà fait.

2. Déroulez le menu Fichier. 

La liste des fichiers .STW disponibles apparaît. 

3. Sélectionnez un fichier .STW ; le fichier est converti dès que vous le sélec-
tionnez.

Dès que la liste apparaît, vous avez converti tous vos fichiers de session. Au 
cours de cette conversion, SmarTerm crée une copie des fichiers .STW orig-
inaux et transforme leur extension en .BAK. Les fichiers convertis sont tran-
scrits en tant que fichiers .STW.

Remarque:
Après avoir testé les nouveaux fichiers de session pour vous assurer de la 
réussite de la conversion, nous vous recommandons de supprimer les fichiers  
.BAK qui ne seront plus utilisés par SmarTerm.

N’oubliez pas
Si l’ancien fichier .STW utilisait un script de connexion (.psl), il est converti 
au nouveau langage de macros et incorporé dans le nouveau fichier de ses-
sion. (N’oubliez pas que les fichiers .PSL doivent se trouver dans le dossier 
\Macros.)
9



Pour Démarrer
Si vous disposiez d’un fichier .STW qui se connectait à un hôte via un 
modem, il sera converti au type de connexion Série directe. Vous devrez donc 
créer un nouveau fichier .STW à utiliser avec un modem. (La version 7.0 ou 
ultérieure de SmarTerm utilise l’interface TAPI de Microsoft, plutôt que 
l’interface SmarTerm propriétaire de nos anciens produits.) 

Les paramètres de la boîte de dialogue Préférences des produits antérieurs à la 
version 6.0 ne sont pas convertis au nouveau format .STW. 

Mettre à jour les fichiers de clavier (.KBO)

Remarque:
Si vous convertissez des fichiers de mappes de clavier supplémentaires 
TN3270, vous devez remplacer l’extension .KB2 par .KBO avant la conver-
sion au nouveau format SmarTerm.

1. Démarrez SmarTerm, si ce n’est pas déjà fait. 

2. Sélectionnez Outils > Mappes de clavier. 

La liste des mappes de clavier disponibles et des anciens fichiers .KBO appa-
raît.

3. Sélectionnez un fichier de mappe de clavier puis cliquez sur Edition.

4. Sélectionnez Fichier > Enregistrer.

Dès que vous l’enregistrez, l’ancien fichier .KBO est converti au format de la 
version 8.0. Lors de cette conversion, SmarTerm crée une copie des fichiers 
.KBO originaux et remplace l’extension par .BAK. Les fichiers convertis sont 
transcrits en tant que fichiers .KBO.

Remarque:
Après avoir testé les nouvelles mappes de clavier pour vous assurer de la réus-
site de la conversion, nous vous conseillons d’éliminer les fichiers .BAK qui 
ne seront plus utilisés par SmarTerm.
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  1 Installation de SmarTerm
Que faire ensuite ?
Pour des informations sur l’Administrator Toolbox, notamment la création 
de profils et de serveurs de profils ou le déploiement de SmarTerm pour les 
utilisateurs réseau, consultez la publication System Administrator Guide (en 
anglais uniquement).
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Vorwort
Dieses Handbuch Erste Schritte ist Ihnen bei der Installation von SmarTerm 
auf dem PC. Es enthält, in Kombination mit dem ausführlicheren Online-
Hilfeystem und den Online-Handbüchern, alle Informationen, die Sie für die 
Verwendung von SmarTerm benötigen.

Die in diesem Handbuch enthaltene Anleitung zur Installation von Smar-
Term ist in vier Sprachen verfügbar – Englisch, Französisch, Deutsch und 
Spanisch – und bietet einen Überblick über den Installationsvorgang. 
Anweisungen zur Ausführung des Setup-Programms finden Sie unter 
“Installation von Smarterm”.

Informationen über die Administrator Toolbox, sowie über das Erstellen von 
Profilen und Profilservern, das Ausführen des Installationsassistenten oder 
den Einsatz von SmarTerm in einem Netzwerk finden Sie im System Admin-
istrator Guide (nur auf Englisch erhältlich).

Auskunft und technischer Kundendienst 
Wenn Sie auf Probleme mit SmarTerm stoßen, gehen Sie bitte zuerst in der 
Online-Hilfe und SmarTerm-Dokumentation durch. Sollten Ihre Probleme 
weiter bestehen und Sie Hilfestellung benötigen, wenden Sie sich an die 
technische Kundendienstabteilung von Esker.

Bevor Sie den technischen Kundendienst anrufen:

•  Halten Sie Ihre Lizenznummer bereit. Sie befindet sich auf der Registri-
erungskarte, die Ihrem Produkt beigelegt ist. (Wenn Sie diese Lizenznum-
mer während der Installation eingegeben haben, können Sie sie mit dem 
Befehl "Info" im Menü "Hilfe" anzeigen.)

•  Unter Umständen benötigen wir detaillierte Informationen zur Hardware 
und Software auf Ihrem Computer. Es ist deshalb hilfreich, wenn Sie mit 
der Verwendung von Windows, der Konfiguration Ihres PCs und Ihrer 
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Erste Schritte
spezifischen Benutzung von SmarTerm vetraut sind bzw. Auskunft darüber 
geben können.

•  Isolieren Sie das Problem so weit wie möglich. Tritt das Problem jedes Mal 
auf, wenn Sie eine bestimmte Tastenfolge ausführen, oder müssen Sie zue-
rst einen anderen Vorgang durchführen? Das Problem kann leichter isoliert 
werden, wenn Sie die einzelnen Schritte zum Nachvollziehen des Fehlers 
kurz schriftlich festhalten. 

•  Begeben Sie sich zu dem PC, der Ihnen Schwierigkeiten bereitet, und rufen 
Sie uns von da aus an. Eventuell müssen Sie einen oder mehrere Diag-
nosetests für uns durchführen, die nur auf dem Computer mit dem Problem 
ausgeführt werden können.
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Installation von Smarterm

Smarterm besteht aus einer Reihe von Windows-Anwendungen, mit denen 
Sie Online-Verbindungen über die heute gängigsten Verbindungsmethoden 
herstellen können. Smarterm ist ein mehrsprachiges Produkt, das Ihnen die 
Wahl zwischen einer englischen, französischen, deutschen und spanischen 
Oberfläche bietet, zwischen denen Sie wechseln können, ohne die Verbind-
ung zum Host abbrechen oder Smarterm beenden zu müssen.

Dieses Kapitel führt Sie schrittweise durch die Installation von Smarterm.

Installationsvoraussetzungen
Smarterm kann auf jedem System mit folgender Hardware und Software 
betrieben werden:

•  Den Mindestanforderungen an Hardware und Arbeitsspeicher, die für eine 
Windows XP/Windows Vista/Windows Server 2003/Windows Server 
2008 auf einem PC mit einem Intel- oder kompatiblen Prozessor erforder-
lich sind. 

•  Windows XP/Windows Vista 32-Bit oder 64-Bit/Windows Server 2003 
32-Bit/Windows Server 2008 32-Bit oder 64-Bit, mit den neusten Service-
Packs installiert.

•  Bildschirmauflösung von mindestens 800 x 600 mit 256 Farben.

•  Entsprechender Kommunikationshardware und -software, wie ein serieller 
Anschluß oder ein Modem, wenn Sie eine direkte serielle oder eine 
Modemverbindung verwenden wollen.

•  Dem TCP/IP-Stapel von Windows, wenn Sie das Telnet-Verbindungsver-
fahren oder FTP verwenden wollen.

•  Microsoft SNA-Client wenn Sie diese Verbindungsmethode verwenden 
wollen.
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Erste Schritte
•  Adobe® Acrobat Reader 4.0.5 um die Online-Handbücher zu lesen. Sie 
können diese Software von der Adobe-Website herunterladen.

•  46 MB an freiem Festplattenspeicherplatz, um alle Komponenten und 
Sprachen.

Bevor Sie installieren
Lesen Sie sich die nächsten Abschnitte durch, um festzustellen, ob Sie vor 
dem Ausführen des Setup-Programms zur Installation von Smarterm noch 
einige Schritte durchführen müssen.

Halten Sie Ihre Seriennummer bereit
Setup fordert zur Eingabe Ihres Namens, der Seriennummer und des Aktivie-
rungsschlüssels für das gekaufte Produkt auf. (Nach der Installation können 
Sie Ihre Seriennummer anzeigen lassen, indem Sie auf Hilfe>Info klicken.) 
Sie müssen SmarTerm registrieren, um eine Seriennummer zu erhalten.

Fahren Sie andere Windows-Programme herunter
Damit der Installationsvorgang so reibungslos wie möglich verlaufen kann, 
beenden Sie alle im Hintergrund laufende Programme, wie:

•  Anwendungen

•  Virenschutzprogramme

Mehrsprachige Optionen
Sie können das Setup-Progamm auf Englisch, Französisch, Deutsch und Spa-
nisch ausführen. Die für das Setup gewählte Sprache wird zur Standard-
sprache, wenn Sie Smarterm zum ersten Mal starten.

Das Setup-Programm installiert immer die englischen Komponenten; Sie kön-
nen jedoch zusätzlich französische, deutsche und spanische Komponenten 
installieren. Alle installierten Sprachen stehen Ihnen auch in jeder Sitzung zur 
Verfügung, mit der Sie eine Hostverbindung herstellen. Des Wechseln der 
Sprache geschieht auf dynamische Weise, was bedeutet, daß Sie eine Sitzung 
auf Französisch beginnen und dann auf Deutsch weiterführen können, ohne 
die Hostverbindung oder Smarterm zu beenden. Sprachwechsel wirken sich 
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  1 Installation von Smarterm
auf die Menüs und Dialogfelder aus. Die Online-Hilfe ist nur auf Englisch 
erhältlich.

Installationstyp
Sie haben die Wahl zwischen zwei Installationsarten: "Vollständig" und 
"Selbstdefiniert". Vollständig installiert alle Funktionen von Smarterm außer 
der Administrator Toolbox und wird bei einer erstmaligen Installation emp-
fohlen.  Selbstdefiniert ermöglicht es Ihnen, die gewünschten Smarterm-
Komponenten auszuwählen.

Hinweis:
Sollten Sie die Administrator Toolbox installieren wollen, müssen Sie  Selb-
stdefiniert und dann Administrator Tools auswählen, um daraufhin die  
Administrator Toolbox zu installieren.

Wollen Sie SmarTerm in einem anderen Pfad als dem standardmäßig 
angegebenem installieren, wählen Sie Selbstdefiniert und klicken Sie auf die 
Schaltfläche Ändern. Geben Sie dann den von Ihnen gewünschten Pfad ein.

Setup ausführen
Führen Sie das Setup-Programm mit den folgenden Schritten aus:

1. Legen Sie die CD in das CD-ROM-Laufwerk ein, und wählen Sie im CD-
Browser-Fenster “Install Smarterm”. 

Hinweis:
Ist die Funktion “autorun” deaktiviert oder nicht verfügbar, führen Sie smar-
term.exe aus dem Stammverzeichnis der CD aus.

2. Wählen Sie die Sprache für das Installationsprogramm aus.

3. Folgen Sie den Eingabeaufforderungen des Setup-Programms. 

Wenn Sie in einem beliebigen Dialogfeld die Standardwerte nicht ver-
wenden wollen, geben Sie neue Werte ein, oder wählen Sie einen Wert über 
die Felder oder Kontrollkästchen in einem Dialogfeld aus. Wenn Sie die 
entsprechende Antwort auf eine Eingabeaufforderung nicht wissen, können 
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Erste Schritte
Sie detaillierte Informationen zu den Auswahlmöglichkeiten über die Online-
Hilfe abrufen oder einfach die Standardwerte übernehmen.

Hinweis:
Die Konfigurierungsdateien werden für jeden Benutzer unter “Dokumente 
und Einstellungen” für den jeweiligen Benutzer gespeichert. 

Der benötigte Esker Licensing Service zählt mit, wie oft SmarTerm auf dem 
Netzwerk ausgeführt wird. Dies geschieht, indem die Lizenzinformationen 
alle 15 Minuten über den UDP-Port 47474 rundgesendet werden.

SmarTerm von der Evaluierungsversion auf 
die lizenzierte Version aktualisieren

Sobald Sie eine Version von of SmarTerm von Esker Sales oder Ihrem Hän-
dler gekauft haben, können Sie das Esker Lizenzierungsverwaltungs-Dienst-
programm zum Aktualisieren Ihrer Evaluierungsversion von SmarTerm auf 
die lizenzierte Version verwenden.

1. Wählen Sie Start > Programme > SmarTerm > Dienstprogramme > Esker Liz-
enzierungsverwaltung.

2. Markieren Sie das SmarTerm-Produkt, das Sie aktualisieren möchten.

3. Klicken Sie auf die Schaltfläche “Serialisierungsinfo ändern” . 

4. Geben Sie die neue Seriennummer und den Aktivierungsschlüssel ein und 
klicken Sie auf “OK”.

Nun können Sie die lizenzierte Version von SmarTerm ausführen.

Aktualisieren selbstdefinierter Dateien aus 
früheren Versionen

Sie können selbstdefinierte Dateien, die Sie mit einem Smarterm-Programm 
der Version 6.0 oder höher erstellt haben, auch mit dieser neuen Version von 
Smarterm verwenden. Selbstdefinierte Dateien der Version 7.0 bis 11.0 Smar-
term können alle mit dieser Version verwendet werden — eine Dateikonvert-
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  1 Installation von Smarterm
ierung ist nicht erforderlich. Beim Aktualisieren von selbtsdefinierten 
Dateien sollten Sie bestimmte Regeln beachten:

•  Archivieren Sie alle Ihre alten Dateien, d.h., erstellen Sie Sicherungsko-
pien der Dateien auf einem Netzwerkserver oder auf Diskette. Smarterm 
erstellt zwar Sicherungskopien für einige Dateien, Sie sollten jedoch Ihre 
eigenen Kopien für den Fall aufbewahren, daß Sie die alten Dateien noch-
mals verwenden wollen.

•  Konvertierungen werden lokal auf einem PC durchgeführt. Wenn Sie die 
konvertierten Dateien für Netzwerkanwender bereitstellen wollen, können 
Sie sie lokal testen und dann in einem Ordner auf dem Netzwerkserver 
kopieren.

•  Die meisten Konvertierungen erfolgen automatisch, Sie müssen jedoch die 
älteren Dateien in die korrekten Standarddateispeicherorte kopieren. 

Sitzungsdateien (.STW) aktualisieren
1. Starten Sie Smarterm, falls dies nicht bereits geschehen ist.

2. Öffnen Sie das Menü "Datei". 

Eine Liste mit verfügbaren .STW-Dateien wird angezeigt. 

3. Wählen Sie eine .STW-Datei aus. Sobald Sie sie auswählen, wird die Datei 
konvertiert.

Wenn die Liste erscheint, haben Sie alle Ihre Sitzungsdateien konvertiert. 
Während der Konvertierung erstellt Smarterm eine Kopie der originalen 
.STW-Dateien und ändert die Erweiterung zu .BAK. Konvertierte Dateien 
werden als .STW-Dateien ausgeschrieben.

Hinweis:
Nachdem Sie die neuen Sitzungsdateien getestet haben, um festzustellen, ob 
die Konvertierung korrekt durchgeführt wurde, können Sie die .BAK-
Dateien, die nun von Smarterm nicht mehr verwendet werden, entfernen.

Wichtige Hinweise
Wenn in der alten .STW-Datei ein Login-Skript (.psl) verwendet wurde, wird 
dieses in die neue Makrosprache konvertiert und in die neue Sitzungsdatei 
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Erste Schritte
eingebettet. (Denken Sie daran, daß sich .PSL-Dateien im Ordner MACROS 
befinden müssen.)

Wenn eine .STW-Datei über ein Modem mit einem Host verbunden war, wird 
sie in den direkten seriellen Verbindungstyp konvertiert. Sie müssen eine neue 
.STW-Datei zur Verwendung mit einem Modem erstellen.  (Smarterm ver-
wendet nun Microsofts TAPI-Schnittstelle für Windows.)

Die Einstellungen im Dialogfeld "Voreinstellungen" in Produkten vor Version 
6.0 werden nicht in das neue .STW-Format konvertiert. 

Tastaturdateien (.KBO) aktualisieren

Hinweis:
Wenn Sie TN 3270 Addition-Tastaturzuordnungsdateien konvertieren, müs-
sen Sie die .KB2-Erweiterung zu .KBO ändern, bevor Sie sie in das Format 
von Smarterm 8.0 konvertieren.

1. Starten Sie Smarterm, falls dies nicht bereits geschehen ist. 

2. Wählen Sie Tools> Tastaturbelegungen. 

Eine Liste der verfügbaren Tastaturbelegungen und der alten .KBO-Dateien 
wird angezeigt.

3. Wählen Sie eine Tastaturbelegungsdatei aus, und klicken Sie auf "Bearbe-
iten".

4. Wählen Sie Datei> Speichern. 

Sobald Sie die alte .KBO-Datei speichern, wird sie in das Format der Version 
8.0 konvertiert. Während der Konvertierung erstellt Smarterm eine Kopie der 
originalen .KBO-Dateien und ändert die Erweiterung zu .BAK. Konvertierte 
Dateien werden als .KBO-Dateien ausgeschrieben.

Hinweis:
Wenn Sie die neuen Tastaturbelegungen auf erfolgreiche Konvertierung 
geprüft haben, können Sie die .BAK-Dateien entfernen, da diese von Smar-
term nicht mehr verwendet werden.
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  1 Installation von Smarterm
Weiterführende Informationen
Informationen über die Installation der Administrator Toolbox, das Erstellen 
von Profilen und Profilservern oder den Einsatz von Smarterm in einem 
Netzwerk finden Sie im System Administrator Guide (nur auf Englisch 
erhältlich).
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Prefacio
Esta guía Para comenzar le ayudará a instalar SmarTerm en su PC. Esta 
guía, junto con el sistema de ayuda en línea más detallado y con los manu-
ales en línea, le ofrecerá todo lo que necesita para utilizar SmarTerm.

Esta guía proporciona una serie de instrucciones para la instalación de Smar-
Term en el idioma que usted elija (alemán, español, francés o inglés) y ofrece 
unas pautas generales para la instalación. Una vez leído este prefacio, pase a 
la “Instalación de SmarTerm”, donde encontrará instrucciones para ejecutar 
el programa de instalación. 

Para obtener información sobre Administrator Toolbox, incluida la creación 
de perfiles y servidores de perfiles, la ejecución del Asistente de instalación 
automatizada, o el despliegue de SmarTerm para usuarios de red, consulte la 
guía de administración de sistemas: System Administrator Guide (sólo en 
inglés).

Información y apoyo técnico
Si tiene problemas con SmarTerm, consulte la ayuda en línea y la document-
ación de SmarTerm. Si los problemas persisten, llame al Departamento de 
apoyo técnico de Esker. 

Antes de llamar al soporte técnico:

•  Tenga a mano su número de licencia. Se encuentra en la tarjeta de registro 
que viene con el producto. Si ha escrito el número durante la instalación, 
puede ver este número de licencia seleccionando Ayuda>Acerca de.

•  Recuerde que es posible que necesitemos información detallada acerca del 
hardware y del software de su computadora, así que será necesario tener 
conocimientos sobre Windows, la configuración de su PC y el modo de 
utilización de SmarTerm.
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Para comenzar
•  Intente aislar el problema al máximo. Determine si el problema se produce 
cada vez que introduce una determinada secuencia de teclas o si tiene que 
realizar alguna acción previa. Escriba una breve descripción de los pasos 
empleados para reproducir el problema: ayudará a ambas partes a aislarlo.

•   Siéntese ante la computadora que le esté causando problemas y llámenos 
desde ahí. Es posible que le solicitemos que ejecute algunas pruebas diag-
nósticas, que deberán realizarse en la computadora que presenta el prob-
lema.
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Instalación de SmarTerm

SmarTerm es un conjunto integrado de aplicaciones Windows que puede uti-
lizar en línea con los métodos de conectividad más populares de hoy en día. 
SmarTerm es un producto multilingüe, con el que puede trabajar en el idi-
oma de su elección (alemán, español, francés o inglés) y que a la vez le per-
mite cambiar de idioma sin necesidad de desconectarse del host o de salir de 
SmarTerm.

En este capítulo encontrará pasos detallados para la instalación de Smar-
Term.

Requisitos de instalación
SmarTerm puede ejecutarse en cualquier sistema que tenga el hardware y 
software siguiente:

•  La memoria y el hardware mínimo requerido por la instalación de Win-
dows XP/Windows Vista/Windows Server 2003/Windows Server 2008 en 
una computadora con procesadores Intel o compatibles. 

•  Windows XP/Windows Vista edition de 32 o de 64 bits/Windows Server 
2003 edition de 32 bits/Windows Server 2008 edition de 32 o de 64 bits, 
con los últimos service packs  instalado.. 

•  Una resolución de pantalla configurada con al menos 800 x 600 con 256 
colores.

•  Software y hardware de comunicaciones adecuado, como un puerto en 
serie o un módem, en caso de que desee establecer una conexión en serie 
directa o una conexión de módem. 

•  La pila TCP/IP de Windows, en caso de que desee utilizar el método de 
conexión Telnet o FTP.

•  Cliente SNA de Microsoft si prefiere utilizar esto método de conexión.
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Para comenzar
•  Adobe® Acrobat Reader 4.0.5 para leer los manuales en línea. Puede des-
cargar este software del sitio Web de Adobe. 

•  46MB de espacio libre en disco para instalar todos los componentes e idio-
mas. 

Antes de la instalación
Lea los apartados siguientes para ver si tiene que realizar algún paso antes de 
ejecutar el programa de instalación para instalar SmarTerm.

Tenga a mano su número de serie
El programa de instalación le solicita su nombre y el número de serie y su 
clave de activación del producto que adquirió (para ver su número de serie tras 
la instalación, simplemente seleccione Ayuda>Acerca de). Debe registrar  
SmarTerm para obtener un número de serie.

Cierre de programas Windows adicionales
Para que el proceso de instalación sea lo más cómodo posible, cierre los pro-
gramas que se estén ejecutando en procesos de fondo como:

•  Aplicaciones

•  Programas antivirus

Opciones multilingües
Puede ejecutar el programa de instalación en alemán, español, francés o 
inglés. El idioma que seleccione en el momento de la instalación será el idi-
oma predeterminado cuando ejecute SmarTerm por primera vez.

Asimismo, el programa de instalación siempre instalará los componentes en 
inglés, aunque también puede instalar los componentes en alemán, español y 
francés. En cualquier sesión que utilice para conectarse a un host, podrá uti-
lizar cualquiera de los idiomas que haya instalado. El cambio de idioma es 
dinámico, es decir, que puede iniciar una sesión en francés y cambiar a alemán 
sin desconectarse del host o sin salir de SmarTerm. Los cambios de idioma 
afectan a los menús y a los diálogos. La ayuda en línea está disponible sólo en 
inglés.
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  1 Instalación de SmarTerm
Tipo de instalación
Puede seleccionar dos tipos de instalación: Completa y Personalizada. La 
opción Completa instala todas las funciones de SmarTerm excepto Adminis-
trator Toolbox, y es la recomendable en la primera instalación. La Personal-
izada le permitirá seleccionar los componentes de SmarTerm que desee 
instalar.

Nota:
Si desea instalar Administrator Toolbox, deberá elegir Personalizada y luego 
seleccionar Herramientas de administración.

Para instalar SmarTerm en una ruta diferente de la predeterminada, elija la 
instalación Personalizada y haga clic en el botón Cambiar. A continuación 
introduzca la ruta deseada.

Ejecución del programa de instalación
Siga los pasos siguientes para ejecutar el programa de instalación:

1. Introduzca el CD en la unidad de CD-ROM y seleccione Install SmarTerm  
en la ventana de CD Browser.

Nota:
Si la función de ejecución automática está desactivada o no disponible, eje-
cute smarterm.exe, que hallará en el directorio raíz del CD.

2. Seleccione el idioma deseado para el programa de instalación.

3. Siga las indicaciones del programa de instalación.

Si no le gustan los valores predeterminados, escriba valores nuevos o selec-
cione un valor de los cuadros de lista o de las casillas de verificación de un 
cuadro de diálogo. Si no está seguro de la respuesta adecuada a una solicitud, 
consulte la ayuda en línea para obtener información detallada acerca de las 
opciones, o simplemente acepte los valores predeterminados.
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Para comenzar
Nota:
Los archivos de configuración se guardan cuando así lo ordena el cliente en la 
ubicación de configuración y de los documentos del usuario.

El Servicio de licencias de Esker obligatorio realiza un seguimiento del 
número de instancias de SmarTerm que se están ejecutando en una red. Esto lo 
realiza transmitiendo la información de la licencia cada 15 minutos a través 
del puerto UDP 47474.

Actualización de SmarTerm desde una 
copia de evaluación hasta una copia con 
licencia

Una vez compre una copia de SmarTerm de un punto de venta o un distri-
buidor de Esker, puede utilizar la utilidad Esker Licensing Administration 
para actualizar de una copia de evaluación de SmarTerm a una copia con 
licencia. 

1. Seleccione Inicio > Programas > SmarTerm > Utilidades > Esker Licensing 
Administration.

2. Resalte el producto SmarTerm que desea actualizar.

3. Haga clic en el botón Modificar información de serialización . 

4. Introduzca el nuevo número de serie y la nueva serie de activación, y haga clic 
en Aceptar.

En ese instante podrá comenzar a ejecutar su copia con licencia de SmarTerm.

Actualización de archivos personalizados 
de versiones anteriores

Puede utilizar archivos personalizados que haya creado usando un producto 
SmarTerm de la versión 6.0 ó posterior, con esta nueva versión de SmarTerm. 
Los archivos personalizados de las versiones 7.0 a la 11.0 de SmarTerm están 
listos para usar con esta versión —no es necesario convertirlos. Simplemente 
use los archivos de la misma manera que lo hizo en dichas versiones de Smar-
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Term. Hay algunas observaciones que deben tenerse en cuenta al actualizar 
archivos personalizados:

•  Mantenga un registro de todos sus archivos anteriores. Ello implica real-
izar copias de seguridad de los archivos en una ubicación del servidor de 
red o bien en un disquete. SmarTerm crea copias de seguridad de algunos 
archivos, pero lo mejor es que conserve sus propias copias, en caso de que 
alguna vez tenga que utilizar los archivos anteriores.

•  Las conversiones se realizan localmente en un PC. Si tiene la intención de 
que los archivos convertidos estén disponibles para los usuarios de red, 
puede probarlos localmente y copiarlos en la carpeta del servidor de red.

•  La mayoría de las conversiones se realizan automáticamente, pero tiene 
que copiar los archivos anteriores en las ubicaciones correctas de archivos 
predeterminados. 

Actualización de los archivos de sesión (.STW)
1. Inicie SmarTerm si aún no está en ejecución.

2. Despliegue el menú Archivo. 

Aparecerá una lista de archivos .STW disponibles.

3. Seleccione un archivo .STW. Se convertirá tan pronto como lo haya selec-
cionado.

Una vez haya aparecido la lista, habrá convertido todos los archivos de 
sesión. Durante la conversión, SmarTerm realiza una copia de los archivos 
.STW originales y cambia la extensión a .BAK. Los archivos convertidos se 
graban como archivos .STW.

Nota:
Después de comprobar los nuevos archivos de sesión para ver si la conver-
sión se llevó a cabo correctamente, es posible que desee eliminar los archi-
vos .BAK, que SmarTerm ya no necesitará más.

Algunas observaciones
Si el antiguo archivo .STW usaba un archivo de inicio de sesión (.psl), ahora 
se convertirá al nuevo lenguaje de macros y se integrará en el nuevo archivo 
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Para comenzar
de sesión. Recuerde que los archivos .PSL tienen que estar en la carpeta 
\MACROS.

Si tenía un archivo .STW conectado a través de un módem a un host, este 
archivo se convertirá al tipo de conexión en serie directa. Deberá crear un 
nuevo archivo .STW para ser utilizado con un módem. (SmarTerm utiliza la 
interfaz TAPI de Microsoft.)

Los valores del cuadro de diálogo Preferencias en los productos anteriores a la 
versión 6.0 no se convierten al nuevo formato .STW. 

Actualización de los archivos de teclado (.KBO)

Nota:
Si está convirtiendo los archivos de mapa de teclado adicionales TN3270, 
necesitará cambiar la extensión .KB2 a .KBO antes de pasar al nuevo formato 
de SmarTerm.

1. Inicie SmarTerm, si todavía no se está ejecutando. 

2. Seleccione Herramientas>Mapas de teclado. 

Aparecerá una lista de los archivos .KBO antiguos y de los mapas de teclado 
disponibles. 

3. Seleccione un archivo de mapa de teclado y haga clic en Editar. 

4. Seleccione Archivo>Guardar.

Cuando haya guardado el archivo .KBO antiguo, éste se convertirá al formato 
de la versión 8.0. Durante la conversión, SmarTerm realiza una copia de los 
archivos .KBO originales y cambia la extensión a .BAK. Los archivos con-
vertidos se graban como archivos .KBO.

Nota:
Cuando haya probado los mapas de teclado nuevos y haya visto que la conver-
sión ha sido correcta, es aconsejable que elimine los archivos .BAK, que 
SmarTerm no vaya a utilizar más. 
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  1 Instalación de SmarTerm
El paso siguiente
Para obtener información sobre la instalación de Administrator Toolbox, la 
creación de perfiles y de servidores de perfiles o el despliegue de SmarTerm 
para usuarios de red, consulte la guía de administración de sistemas: System 
Administrator Guide (sólo en inglés).
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